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What is 
WordPress? 



WordPress: 
Software/App/Content Management System used for creating 

websites and blogs.

Core files/folders ---->  

Made with PHP/HTML/CSS/JS

Uses SQL Database

Lives in LAMP/LEMP Environment

Extensible through plugins and themes

Open Source & free



<3 Your Database

Most WordPress site content is stored in a 
SQL database. 

● post content
● page content
● comments
● user data 
● permalinks / slugs 
● attachments

A database is a system for storing data 
so applications and websites can 
retrieve that data efficiently and on 
demand. 

Databases use ‘tables’, ‘rows’ and 
‘columns’ as the pillars of its 
structure, much like a spreadsheet.



 
Do

● Keep core, plugins, themes up to date. 
● Database < 2GB and _options < 5MB
● Home page < 3 MB
● Size images to-scale, 72 DPI and < 1 MB
● Use a CDN (Content Delivery Network)
● Use cache and minifying
● Use a crawl delay and CAPTCHA
● Use php.ini, akismet and lazy load
● Place Javascript just before </body>  tag
● Use a DNS firewall service, like CloudFlare.
● Hide wp-admin.
● Use a reliable hosting platform.  

Don’t

● Keep plugins, themes or media 
you are not using. 

● Use forms, logins, ads or 
sessions on home page.

● Use real-time backups or page 
view counters. 



Types of 
Hosting 

Shared: Great to start out on but 
has limited resources and noisy 
neighbors.

Cloud: Highly scalable, global 
distribution, redundant. 

Private/Dedicated: More reliable 
hardware, less scalable.



● Managed hosting - Hosting 
company will maintain server 
hardware and software for you.

● Server-side cache - Hosting 
company will configure exceptions 
and debug for you

● Current Linux and software 
versions. 

● Stellar service is a must.
● Data center should be close to 

your audience. 
● SQL location should also be close.

Hosting 
Features 



PHP Environment & php.ini
• Use PHP 7.1 or higher. PHP 7.3 is fastest.        • Use https/SSL and HTTP/2 

• Use a php.ini file to maintain control over your hosting environment. Look up your host’s 
documentation on how to implement this. Some hosts don’t use a standard php.ini. 

• Recommended php.ini settings: 

• These settings are generous! The limit is per php spawn, so you want to keep them low to 
prevent the potential of rogue spawns. A php spawn is a process created on the server to execute 
a function. Like when buttons are clicked. 



PHP Environment & wp-config.php
• You can set php environment limits in the wp-config.php file. wp-config.php is used for a secure 
database connection and a number of primary settings.  It can be customized. Yay!

Check out:  https://wordpress.org/support/article/editing-wp-config-php/#increasing-memory-allocated-to-php  for more info

*make sure you use straight ‘ and not curly ‘

https://wordpress.org/support/article/editing-wp-config-php/#increasing-memory-allocated-to-php


Front End Tools: .htaccess
An .htaccess file interacts with the Apache service to determine how the site is delivered to visitors. In 
WordPress, the .htaccess file regulates pretty permalinks (links with the post name in them). WordPress 
Generates the .htaccess file for you when permalinks are set. 



Browser-side Cache with .htaccess
Browser-side caching in .htaccess using mod_expires or mod_headers. 

Check this link for more info! Thanks, DreamHost! 
https://help.dreamhost.com/hc/en-us/articles/216363157-How-can-I-cache-my-site-with-an-htaccess-file-

https://help.dreamhost.com/hc/en-us/articles/216363157-How-can-I-cache-my-site-with-an-htaccess-file-


● Browser-side:  htaccess 
● Front End: Plugins
● Server-side: Ngxcache, Varnish 
● Persistent Object: Memcached, Redis
● 3rd party like CloudFlare, Sucuri; 

cache layer outside of the hosting 
system.

Cache
Method of storing data 
temporarily so it can be 
retrieved quickly.

*User Sessions (logins, forms, 
my-account pages) interfere with cache. 

*Cache exceptions can be configured. How 
to do so varies among different types of 
cache.  

*Debugging techniques also vary among 
cache types. 

*When debugging, cache hits and misses 
help identify problem areas.



Minifying

Minification is the removal of white spaces, 
comments and unused code, shortening 
variables, combining scripts and other 
optimizations. You can use a plugin for 
minification. 

● Fast Velocity Minify
● WP Smush
● Autoptimize



Front End Tools: 
JetPack

● Image CDN Module
● Lazy-loading Images Module 
● Image Performance Module
● Site Accelerator
● Option to speed up static file load times

This can be done in wp-admin under          
JetPack -> Settings -> Performance

..or using JetPack Command Line

Has Command Line!
!!!!!!!! 

Check it out: https://jetpack.com/support/jetpack-cli/

https://jetpack.com/support/jetpack-cli/


File and Data Management

You can connect to your server via SSH using a terminal client, to manage your files with command line.

You can edit files in your browser with https://yourdomain.com/wp-admin

You can upload, download, edit files with an S/FTP client like FileZIlla, Cyberduck or similar

You can manage your database content using a client such as PHPmyadmin or MySQL WorkBench

cPanel does all of the above (except SSH)

https://yourdomain.com/wp-admin


Intro to SSH / Command Line Basics
Login with the command ssh username@yourserver.com     (contact your host for credentials and instructions)

Make new file: pico  <filename> Exit pico: ctrl + o to save and ctrl + x to exit

Edit a file: nano <filename>   Exit nano: ctrl + o to save and ctrl + x to exit

Edit a file: vim <filename>     Exit vim: press  esc + shift + ;   then rq + enter (to save)

Move a file: mv <filename> /new/location/

Copy a file: cp -r <filename> <newfilename>       Delete a file: rm -R <filename>

Navigate between folders: cd /path/to/folder  Navigate one folder backwards: cd ..

Check CPU usage: top -c           Check memory usage: free -m

mailto:username@yourserver.com


SSH / Command Line Basics



Working with WordPress Command Line

Check Installed Themes and Their Status with           
‘wp theme list’ and ‘wp theme status’

Check installed plugins and their status with                            
‘wp plugin list’ and ‘wp plugin status’

Make sure WordPress is up to date! Check 
WP Core version with   ‘wp core version’

: 

*Find more commands on: https://developer.wordpress.org/cli/commands/

https://developer.wordpress.org/cli/commands/


WP Cli Updates, Re-Installs, Un-Installs

Update Plugins and Themes                                  ‘wp 
theme update <theme>’    ‘wp plugin update <plugins>’

Install, Un-Install, Deactivate, Activate                              
‘wp plugin install <plugin>’   ‘wp plugin uninstall <plugin>’                           
‘wp plugin activate <plugin>’   ‘wp plugin deactivate <plugin>’

Update Core, Force Core Download, Flush Cache     
‘wp core update’    ‘wp core download’   ‘wp cache flush’



Checksums & Scans

Verify plugin health with ‘wp plugin verify-checksums --all’

Verify Core health with ‘wp core verify-checksums’

Responsive Lightbox needs to be reinstalled! 



Checksums & Scans

Sucuri offers a free malware scanner at: https://sitecheck.sucuri.net



Fix a Hacked WordPress

1) Reset all passwords ( `wp user reset-password admin editor`)   
2) Export Database (`wp db export`)
3) Rename public_html directory and create new, empty one using a mv command. 
4) Install a fresh WordPress core (`wp core download`) in new public_html
5) Update wp-config with new salts and new db credentials
6) Re-install Plugins and Theme (`wp plugin install <plugin>` `wp theme install <theme>`) 
7) Import database (` wp db import <filename>`) 
8) Reset permalinks or make new .htaccess                                                                                

(wp rewrite structure '/%year%/%monthnum%/%postname%/')
9) Copy over /wp-content/uploads if not containing hacked files using a cp -r command 

10) If the database is hacked, export the hacked table, use SED to clean it, drop the live table 
and re-import the clean table. 



Debugging 

Pinpointing the Source of Error



Debugging Tools

Browser Developer Tools

php.ini

wp-config.php 

Site Health Module

WordPress Command Line 

Error logs

Software such as Xdebug, New Relic, Zabbix, 
Nagios, Grafana... 



Debug
With

Browser 
Developer 

Tools

Found under ‘View -> Developer -> Developer Tools’ in Chrome  

and ‘Tools -> Web Developer’ in FireFox



Error reporting with php.ini and wp-config.php

Add code to your php.ini file to enable error 
reporting. Syntax will vary from host to host.

Add code to your wp-config.php file to enable error 
reporting. 

Displays errors on website or 
use an error log...

*This creates an error.log in your wp-content folder.



Site Health Check Module in Core

Since WordPress 5.2 the Site Health Module has been integrated into WordPress Core and can be 
found under Tools -> Site Health in the wp-admin dashboard.



Site Health Check Dashboard
The Site Health Module provides detailed information as well as fatal error recovery. By 
default Site Health will disable the source of a fatal error and email the admin. 





Find Bottlenecks with WP Profile

*Thank you to developer.wordpress.org for providing an incredible resource! 



WP Profile Stage

Breaks the site load process in three stages: 

● Bootstrap: WordPress getting set up.  
● Main_query: WordPress processing requests.
● Template: WordPress rendering theme. 

‘wp profile stage’ can be used to measure load times for each stage as well as 
cache misses.



WP Profile Stage <stage>

*More info found here: https://developer.wordpress.org/cli/commands/profile/stage/

Breaks the specified stage down by each hook.

https://developer.wordpress.org/cli/commands/profile/stage/


Understanding Errors

Error Types

● Fatal Error: Website is broken, scripts have stopped running. Code can 
be read but not executed. 

● Parse Error: Code syntax is incorrect. Script execution stops. 
● Warnings: Just a heads up. Scripts keep running. 
● Notice: Same as Warnings but usually refers to an undefined function or 

variable. 



Common Errors
● Allowed memory size of bytes exhausted: Memory is 

maxed out. Increase memory or kill processes eating up memory (or 
both). 

● HTTP Error: Usually related to php environment. Increase php 
environment settings; max spawns, max memory, execution 
time..make sure gd or imagick extensions are working, make sure 
disk and /tmp are not full. 

● Error Connecting to Database: Check wp-config for syntax 
errors (like curly single quotes) and incorrect credentials. Check 
SQL service and SQL server uptime. Check for database corruption. 
Repair if needed. Check for database DDOS with a SQL Syntax 
‘show full processlist’

● 404 Page Not Found: Check .htaccess for mistakes. Reset 
permalinks. Make sure correct theme is in use. Check permissions. 
Make sure files are in the correct place and DNS is correct.



Common Errors
● Stuck in Maintenance Mode: Delete or rename .maintenance 

file in public_html directory.
● WSOD: Check for fatal PHP errors. Flush cache. Usually caused by 

malfunctioning theme or plugin. Delete default.html if present. 
● Internal Server Error 500: Often from a malfunctioning 

plugin or theme. Could be from high resource usage, incorrect 
permissions, full disk, fatal PHP error, Apache/Nginx error or DDOS. 

● Connection Timed Out: Increase execution time. However you 
will want to troubleshoot to find the source of the long running 
processes. 

●  Deprecated Code: Some code in the install is outdated and will 
expire soon. Update install and code.



Taking 
Care
Of
Your
SQL
Database

● In a database, data is stored in tables, rows 
and columns, like a spreadsheet. 

● A WordPress Database should ideally be 
be less than 2 GB total,

● _options table should be less than 5 MB. 
The _options table is used by every part of 
the site. Keep it minimal.

● Keep autoloaded data under 1 MB
● _posts tables can become large (2GB+)  on 

news sites and blogs. This should be fine if 
you keep it well optimized and indexed, and 
make sure you don’t use queries that select 
the entire table.. 



Database and WP Cli (WordPress Command Line)

Run a ‘‘wp db size’ 
command to check 
database size!.

•Always take a backup before working on 
a  database! You can export a backup 
with WP Cli  ‘wp db export’ command.

WordPress Command Line can do 
everything wp-admin does++ !



Database Health Check and Repair with WP Cli

Check for corruption with ‘wp db check’ Repair/recreate DB with ‘wp db repair’ 

*just a 
warning..
can 
ignore.

*More commands found here: https://developer.wordpress.org/cli/commands/db/

https://developer.wordpress.org/cli/commands/db/


Connect directly to Your Database using WP CLI

Connect to your MySQL service 
directing with a ‘wp db cli’ command.



Talk To Your Database with SQL Syntax
view table names 
`with show tables;`:

Get table details with ‘desc <tablename>;’

*SQL Syntax is a  type of command line and code that 
can be used to communicate with a database. To view 
details of what SQL queries are currently running, use 
the ‘show full processlist;’ command. A few more …

*WP Core uses 12 tables



Talk To Your Database with SQL Syntax
*This is what a Brute Force attempt on the database 
looks like…



Database Optimization: Use InnoDB
● InnoDB: can lock on rows, while MyISAM only locks on tables.
● InnoDB: is more recoverable with better logging. 
● InnoDB: supports transactions, which means you can test or undo a change. 
● Use SQL Syntax to check what Engine is in use: 

● Use SQL Syntax to convert to InnoDB:                                                          
‘ALTER TABLE table_name ENGINE=InnoDB;’



Database Optimization: Indexing with SQL Syntax
An Index is a type of data structure within a database that makes information more accessible and 
streamlines performance, requiring less from the server per query.You can check if a table is 
already indexed using SQL Syntax, with a `SHOW INDEX FROM tablename;` command.



Database Optimization: Indexing with SQL Syntax

This table doesn’t need indexing, but if it did you would use the following commands to create or 
drop (delete) and index:
`CREATE INDEX indexname ON tablename(column1, column2); ‘
`DROP INDEX indexname ON tablename(column1, column2); ‘



Database Optimization: Clean Up _options table
Delete Expired Transients from the options table with the WP Cli command ‘wp transient delete’. You 
will have to leave the SQL environment with an ‘exit’ command. Transients are used by themes and 
plugins to store data temporarily, sort of like cache. 
Looks like this: 

More info on wp transient:  https://developer.wordpress.org/cli/commands/transient

Back to SQL with ‘wp db cli’. Find and delete old sessions rows using SELECT and DELETE (SQL 
Syntax). Session rows are leftover when crons become out of sync. 

*no sessions rows in this db!

https://developer.wordpress.org/cli/commands/transient


Cron jobs are automated processes that are pre-scheduled and often run at regular intervals. If crons 
don’t execute properly (for instance if memcached is broken) they may get backed up and never 
clear out. You can clear cron data manually from the _options table with SQL Syntax. First SELECT 
the rows and then UPDATE with a new (empty) value. 

database_name.prefix_table



Locate automatically loaded data (to delete it) in  _options table. Autoloaded data is usually leftover 
from plugins and isn’t always cleared out properly especially after uninstalls, causing it to pile up. 
Look how much autoloaded data is in my options table! 

Shout out to Kinsta for having incredible documentation: https://kinsta.com/knowledgebase/wp-options-autoloaded-data/

https://kinsta.com/knowledgebase/wp-options-autoloaded-data/


Let’s delete that first one as an example, using an SQL Syntax DELETE statement. SQL syntax is 
not case sensitive but using upper case for SQL Syntax is the standard because it provides more 
clarity. 



Database Optimization: Clean Up _posts Table
Multiple versions of posts are saved during editing. These are called Revisions. Revisions are 
saved in the database _posts table. Big sites, especially news sites and blogs, tend to have a lot 
of revisions cluttering up the db. Delete old revisions using SQL Syntax: 

Still working on the _posts table, as part of housekeeping you can delete trash 
posts using SELECT and DELETE:



Database Optimization: Clean Up _posts Table
Prevent revisions from building up by setting a limit on revision quantity and frequency of 
automatic saves in your wp-config.php file: 



When the content of two (or more) 
posts are linked together, the links are 
saved in the database as something 
called a  relationship in the a 
_term_relationships table. In this 
statement we’re working with two tables 
again, only this time using two 
SELECTs instead of a JOIN. 

Database Optimization: Clean Up term_relationships



Database Optimization: Clean Up _postmeta
Orphaned (abandoned) postmeta data can be cleaned up using a JOIN statement, which 
connects two tables together to perform a function on both. Meta data is the data associated with 
the page or element that is not visible. Always SELECT the data you want to work with first as a 
precaution: 



Database Optimization: Clean Up _postmeta
Once you have viewed the data you want to work with and are ready to move forward you can go 
ahead and DELETE. In this statement m acts as a variable standing in for the postmeta content. 
NULL is a blank value (not to be confused with no value at all): 

This isn’t my code! I borrowed it from this awesome article: : 
https://metinsaylan.com/8202/12-useful-sql-queries-for-wordpress-database-cleanup/

https://metinsaylan.com/8202/12-useful-sql-queries-for-wordpress-database-cleanup/


Database Optimization: Clean Up _comments Table
Delete spam, pingbacks and trash comments from _comments table. When a 3rd party 
site links to yours a notification is saved in the DB, called a pingback. Use a LIMIT to 
determine how many rows can be deleted at a time so as not to overwhelm the server: 



Database Optimization: Clean Up _comments Table
When you DO have something to delete, if you use a LIMIT you will have to run the command 
repeatedly until it says 0 rows affected. Command to delete unapproved comments:

Type ‘exit’ to exit out of MySQL.



Database Optimization: ‘wp db optimize’
Always run a ‘wp db optimize’ after 
working on the database. This runs a SQL 
Optimize and pushes changes through.

More info on wp db optimize: https://developer.wordpress.org/cli/commands/db/optimize/
More info on SQL Optimize: https://dev.mysql.com/doc/refman/5.7/en/optimize-table.html

https://developer.wordpress.org/cli/commands/db/optimize/
https://dev.mysql.com/doc/refman/5.7/en/optimize-table.html


Finish up with a ‘wp cache flush’

Always run a ‘wp cache flush’ after 
cleaning up and optimizing the database. 
This flushes the persistent object cache.

More info: https://developer.wordpress.org/cli/commands/cache/flush/

https://developer.wordpress.org/cli/commands/cache/flush/



